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Practice CS, v. 2011.2.0 
User Bulletin 6801: Software Update 
 
November 7, 2011 
 
TO  
All Practice CS® users. 
 
This user bulletin explains changes made to this release of Practice CS. 
 
CHANGES 
Many of the enhancements that are available in this update are protected by security privileges. If your 
firm has enabled firm security, please evaluate all enhancements and update your security groups as 
needed.  
 
For additional information about using the enhancements, see the “What’s new in Practice CS” help topic. 
From the Help menu, choose Practice CS Help Topics, click the Contents button in the help browser, and 
then click “What’s new in Practice CS” at the top of the table of contents. 
 
Version 2011.2.0 of Practice CS includes the following changes.  
 
Mobile CS 
Mobile CS users must download and install the latest version of Mobile CS Link for Mobile CS to work 
with Practice CS v.2011.2.0. To download and install Mobile CS Link, visit the Support section of our 
website at CS.ThomsonReuters.com, and click My Product Downloads.  
 
System 
 Specified staff can now receive a notification when a client has exceeded the A/R or WIP limits set in 

client setup.  
 Practice CS now displays a reminder in the status bar if your firm hasn’t backed up its database in the 

last two days.  
 In date fields you can now press ‘CTRL’ + ‘+’ to advance the date by one day and ‘CTRL’ + ‘-‘ to 

move back one day.  
 SQL Server 2008 R2 Express is now installed when you choose to install a new instance of SQL 

Server during Practice CS installation. 
 
Integration 
 With 2011 UltraTax CS,® you will be able to display the UltraTax CS client complexity value in 

Practice CS schedule item grids.  
 With 2011 UltraTax CS, you will be able to display the UltraTax CS return history in the Practice CS 

UltraTax CS Return History portlet on the Client Dashboard for 1040 clients.  
 We added Accounting CS™ as a solution for projects and tasks. Click the Accounting CS icon in the 

Manage Project screen to launch Accounting CS and start a timer.  
 
Setup screens 
 Four types of contacts are now available for clients. 

 Primary Contact 
 Preferred Contact — The preferred contact is the primary contact for the client unless your firm 

specifies otherwise. The preferred contact is the person at the client’s office that your firm prefers 
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to be in contact with and can be any contact in your database. In Practice CS, you can set up one 
contact as the preferred contact for many clients.  

 Billing Contact — The billing contact is the primary contact for the client unless your firm specifies 
otherwise. The billing contact is the person who should receive invoices and statements for the 
firm and can be any contact in your database.  

 Additional Contacts — Any additional contacts for the client. 
 You can use these new contact types to filter and group contact screens, reports, letters, and labels.  
 We added a new Contact list to the Contact Info tab of Client Setup. This contact list allows you to: 

 select different views for your list of contacts showing as much or as little of their information as 
needed.  

 easily view and edit all information for the contact that is currently selected in the list.  
 We added a Display as field to Contact Info tabs for each email address. This allows all email 

addresses to integrate with Microsoft® Outlook.®  
 If you are licensed for NetFirm CS,™ the following NetFirm portal administration is available to you 

through Practice CS: 
 For all clients and standalone contacts, you can now add new NetClient CS® portals or find and 

assign existing portals.  
 For all staff and offices, you can now add new NetStaff CS® portals or find and assign existing 

portals.  
 Practice CS now provides assistance with finding and selecting existing NetClient CS and 

NetStaff CS portals for clients, staff, contacts, and offices.  
 We added a Firm Preference that allows you to create NetClient CS portals or NetStaff CS 

portals automatically for new clients, prospects, or staff when you add them to Practice CS. 
 
Time and expense entry 
You can now press CTRL + ” to copy the value from the previous row into the current row in Time and 
Expense Entry fields.  
 
Billing 
 We added a user preference, Default WIP through date, for billing. This user preference allows you to 

limit billable time and expenses to a date prior to the invoice date.  
 We added a new firm billing and A/R option, Enable default invoice reference number, through which 

you can add reference numbers to invoices automatically. You can customize your default invoice 
reference numbers based on several criteria (invoice number, date, partner, office, invoice count, and 
so on). 

 You can now add custom fields to invoices.  
 You can now edit a client’s billing instructions in detail billing. Practice CS reflects the change in the 

Billing instructions field of the Billing and A/R tab of the Clients setup screen.  
 We added a column for the date last generated to the Recurring Bills tab of the Billing screen. This 

enables you to filter the list for only the recurring bills you want to generate.  
 Practice CS now limits the results on the Review tab of the Billing screen when filter and search 

criteria return a large number of results. The result limits will significantly improve program 
performance in this screen.  

 
Receipt and adjustment entry 
 You can now enter receipts by invoice number when you set your user preferences to display the 

Invoice Search column.  
 You can now close Credit Card Return adjustment entries with applications from other receipts and 

adjustments.  
 
Dashboards 
 We added columns for custom fields and links to the Prior Invoices portlet. 
 When you mark the Ready Tasks only checkbox, you can view only those tasks that are ready in the 

Work Queue portlet.  
 You can now search and filter in the Schedule Items and Work Queue portlets. 
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 You can now filter the Schedule Items portlet using relative date groupings such as Today, 
Yesterday, Last week, Two weeks ago, and so on.  

 We added a Field Chooser to the Work Queue and Schedule Items portlets. This chooser allows you 
to select the columns you want to view in the grids.  

 
Security 
We added a security privilege that allows you to mask the EIN/SSN fields for staff who should not be able 
to view the full EIN/SSN of clients or staff. 
 
Manage clients 
 You can now filter clients and contacts by their city, state, and ZIP.  
 You can now group the Date/Time column of the Interactions tab by relative dates such as Today, 

Yesterday, Last week, Two weeks ago, and so on.  
 In the Clients, Contacts, and File Transfers tabs, you can select the columns to view in the grids 

through a Field Chooser.  
 On the Clients tab, you can now edit the properties of several clients at a time by right-clicking the list 

of clients and choosing Edit Multiple Clients from the context menu.  
 On the Contacts tab, you can now edit the properties of several contacts at a time by right-clicking the 

list of contacts and choosing Edit Multiple Contacts from the context menu.  
 If your firm is licensed for NetFirm CS, you can now transfer files to your clients securely with our 

easy-to-use file transfer feature. You can send files with the option to request an electronic signature 
from your client, or request that your client send files to you. 
 Files that you send are transferred to your client’s NetClient CS portal. 
 You can add new NetClient CS portals for contacts “on the fly” as you initiate file transfers. 
 You can view the status of the transfer in the File Transfers tab of the Manage Clients screen or 

in the File Transfers portlet on the Firm, Staff, or Client Dashboard.  
 Practice CS automatically creates an interaction for the client with each file transfer event.  
 In the Notifications tab of the Firm setup screen, you can select staff who should receive 

notifications for events related to file transfers, such as when a client downloads or signs a 
document. 

 You can now add links to all interactions.  
 Practice CS now limits the results in all tabs of the Manage Clients screen when the criteria return a 

large number of results. The result limits will significantly improve program performance in this 
screen.  

 
Manage projects  
 Practice CS now provides options for resolving conflicting dates when target dates change for a 

project or task.  
 Practice CS no longer ties project and task target dates to the project’s due date. 
 Practice CS now calculates remaining hours for projects and tasks. Practice CS enables you to use 

remaining hours for scheduling instead of budgeted hours. 
 You can now assign multiple staff to projects and tasks.  
 You can now set recurring projects to expire after a specified number of occurrences, or on a specific 

date.  
 If you are licensed for the Staff Management module, you can schedule projects and tasks “on the fly” 

in the Manage Projects screen and in project-related portlets.  
 Practice CS now enables project recurrence rules (due dates and target dates) to be independent of 

the template.  
 You can add the Actual Amount, Actual Hours, Budgeted Amount, and Budgeted Hours columns to 

the Manage Projects screen using the Field Chooser. 
 Practice CS now limits filter and search results on the Projects and Project Tasks tabs when the 

criteria return a large number of results. The result limits significantly improve performance on this 
screen.  

 
Manage Staff 
 You can now set up meetings, to-do items, and scheduled phone calls as recurring items.  
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 You can customize the start and end times on Timeline and Day views of calendars.  
 Through the new Firm Calendar, you can view all selected staff members on one calendar instead of 

viewing them in individual calendars.  
 In the Staff, Client, and Firm calendars, you can view schedule items by scheduled dates or target 

dates.  
 You can roll forward schedule dates when you generate new projects. 
 Practice CS now bases remaining hours on both posted and unposted time entries. 
 You can now add links to all schedule items.  
 We added an editable comment column to the benefits detail dialogs. 
 A new Assignments tab makes it much easier for you to assign staff to schedule items. In the 

Assignments tab, you can: 
 view all staff assignments. 
 drag and drop unassigned items such as projects, tasks, or meetings onto the appropriate staff 

calendar to have Practice CS automatically assign that staff member to the item. 
 arrange staff members and their assignments in grids or tiles to provide the view that best suits 

your needs.  
 rank schedule items in a specific order.  
 filter the screen by target or scheduled date ranges. 
 view schedule items in the Urgent subtab that you have defined as Urgent (for example, if they 

are past their target dates or have high priority and are not assigned) via your user preferences. 
 view Infotips that provide detailed information about schedule items without opening those items. 
 use Infotips to see whether staff are qualified for the selected schedule item. 

 We improved performance on the Schedules and Schedule Items tabs. 
 We made enhancements to the Schedules and Schedule Items tabs that enable you to: 

 drag and drop unscheduled projects, tasks, to-do items, and so on, onto the date and time on the 
appropriate calendar to have Practice CS automatically schedule them for that time and that staff 
member. 

 view schedule items in the Urgent subtab that you have defined as Urgent (for example, if they 
are past their target dates or have high priority and are not assigned) via your user preferences. 

 view Infotips that provide detailed information about schedule items without opening those items. 
 use Infotips to see whether staff are qualified for the selected schedule item. 
 schedule items for multiple dates and times. 
 set security privileges to allow staff to see other staff members’ calendars, but edit only their own 

calendars. 
 choose to display Outlook items on scheduling calendars. 
 create calendar categories to color-code calendar entries.  

 
Reporting 
 We enhanced Practice CS to improve the performance of many reports.  
 You can now sort the following reports by amounts: 

 Production Analysis 
 Work-In-Process Summary 
 Billing Analysis 
 Billed Tax Summary 
 Accounts Receivable Applications 
 Accounts Receivable Recap 
 Invoice Receipt Analysis 
 Staff Benefits Summary 
 Staff Target Summary 

 You can now include a visual representation of your report data in the report footer, in the form of 
either a bar chart or a pie chart, by marking the new Print Charts checkbox on the Layout tab. Charts 
are available on the following reports: 
 Production Analysis 
 Work-in-Process Summary 
 Billing Analysis 
 Accounts Receivable Recap 
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 Accounts Receivable Summary 
 Collection Summary 
 Invoice Receipts Analysis 
 Client Investment Analysis 
 Period Reconciliation 

 You can now add customized charts to standard and custom reports, and you can customize existing 
charts using the Chart Wizard in the Custom Formats screen.  

 You can now filter and group client-based reports, contact-based reports, letters, and labels by city, 
state, and ZIP.  

 New scheduling reports have been added for the Manage Staff module. 
 Calendar Listing 
 Schedule Item Detail 
 Staff Capacity Analysis 
 Staff Assigned Summary (formerly called Staff Schedule Summary) 
 A new Staff Schedule Summary 

  
SUPPORT 
Practice CS help 
For step-by-step procedures, refer to the Practice CS help. To learn how to use the help, choose Help > 
Practice CS Help Topics and double-click the topic “Getting Help with Practice CS.” 
 
Website  
If you have questions or need assistance, you can visit our website at CS.ThomsonReuters.com 24 hours 
a day for access to our support knowledgebase and for the latest information on current issues and 
processing tips. To take advantage of this convenient means of accessing information, choose On the 
Web from the Practice CS Help menu, and then choose Support Knowledgebase or Product Support 
and Services. 
 
Email subscriptions 
We issue software update notices via email. If you want to receive these notices, you must have an email 
account and sign up for the Email Subscription service. To sign up for the Email Subscription service, visit 
the My Account section of our website at CS.ThomsonReuters.com. (Note that you must create a web 
account to sign up for email subscriptions.) 
 
Product support 
To speak with a Product Support Representative, please call CS Support at (800) 968-0600, press 2 for 
Product Support, and then listen to the available options. Normal weekday support is available from 9:00 
a.m. to 8:00 p.m. eastern time. For details on extended support hours for tax season and for our support 
hours for all CS Professional Suite® applications, please visit the Support section of our website 
(accessible from within Practice CS by choosing Help > On the Web > Product Support and Services). 
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